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INTRODUCTION

This tutorial is meant to get new MicroFEM users quickly familiar with MicroFEM. It is done
by a step by step instruction on how to solve a simple groundwater flow problem using
MicroFEM.

Things which will be covered are:

e How a Finite Element Network for MicroFEM is set up

e How hydraulic parameters are entered (viz., transmissivity, vertical hydraulic resistance)

e« How boundary conditions are to be entered (precipitation, fixed head versus impermeable
model boundaries, abstractions, phreatic versus (semi-)confined groundwater, ...)

e How a visual check on proper input of boundary conditions and hydraulic parameters can

be obtained

How the model can be calculated in steady state and unsteady state

How time dependent groundwater flow can be modeled with MicroFEM

How primary graphical results can be obtained (contour plots, flow vectors, ...)

How other (text) results can be obtained (water balances, ...)

How yet other graphical results can be generated (time-head graphs; cross sections; head

profiles; 3D flowlines, ...)

¢ and to some extent, how to adapt MicroFEM to your personal preferences.

On the way, the maijority of the menu commands and buttons of the MicroFEM Graphical
User Interface (GUI) will be used. Some tricks to efficiently accomplish various tasks will also
be covered.

Almost all buttons have an associated menu command and vice versa, and many of these in
turn have keyboard equivalents. In the text below, all these ways to enter a command will be
used at least once; however, emphasis is laid on mouse use (buttons).

Things which will NOT be covered are:

e The mathematical background of finite elements (and for that matter, any other mathematical
modeling procedure)

e Basic concepts needed for understanding how groundwater models work

o Basic Windows™ operating system proficiency (mouse, focus, menus, buttons, etc.)

e The many ways that a hydrological problem can be translated into a form which can be
fed to a groundwater model

¢ The many ways that the output from a groundwater model might be interpreted and then
translated into solutions for the actual problem at hand

e More complex top boundary conditions, e.g., drains, rivers, wadis, evapotranspiration,
etc., and more complex internal boundary conditions (impermeable internal boundaries, open
water, etc.) or other advanced subjects (e.g., multiple aquifers, transient water balances, flux
functions).

e Calibration of the tutorial model, or for that matter, any groundwater model in general

e Linking MicroFEM to other software (GIS; chemical flowpath modelling; pre- or postprocessing
of graphical results; etc.)

e etc.

So, this tutorial is primarily meant to get groundwater hydrologists started who have some
prior modeling experience with other groundwater modeling software under MS-Windows™.
For more advanced subjects, please consult the on-line help (which contains a wealth of
advanced information) or if that doesn't provide an answer, e-mail to support@microfem.nl

This tutorial is set up in such a way that the freeware trial demo of MicroFEM can be used
throughout (http:/www.microfem.nl/). This demo version has all functionality of the full
program but limited capacities.

December 2010 3 of 57



MicroFEM tutorial version 4.10

THE EXAMPLE PROBLEM

This tutorial shows you how MicroFEM can be used to find answers to the following
(synthetic) problem. The example problem used here has been borrowed from Belgian
colleagues' and has been used regularly in a three-day MicroFEM instruction course.

Consider a rectangular area where phreatic groundwater occurs and which is recharged by
precipitation. Groundwater abstracted by a well in the central part of the model area might be
threatened by polluted groundwater from a nearby landfill.

The model area measures 10,000 (east-west) by 6,000 meters (north-south). The landfill is
located at 2,000 m to the south of the northern boundary and 2,000 m to the west of the
abstraction well. This well lies 1,000 m south of the centre of the model area (see Figure 1).
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Figure 1: Overview of model area

There is only one aquifer in the area, which can be considered homogeneous and isotropic,
consisting of sandy deposits (including the unsaturated zone) with a hydraulic conductivity of
12 m/day, an effective porosity of 0.35 and a specific yield of 0.2. This aquifer overlies a thick
clayey series, which can be considered impermeable.

The groundwater is recharged by precipitation at a rate of 240 mm/a; rivers flow along both
the northern and southern boundaries; for the sake of this tutorial these rivers can be
assumed fully penetrating with no entry resistance and having fixed water levels (i.e., not
influenced by the groundwater flow) of 35 m above the top of the clay deposits (see Figure
2).

Because, without well abstraction, the groundwater flow is either to the north or to the south
(i.e., is then only discharged to the rivers), the eastern and western boundaries are assumed
impermeable (since they will be situated along a flowline).

Viaene, P., C. Vlieghe, J. Bellon, M. Buysse and P. de Smedt (1996) Beschrijving van vier
softwarepakketten voor grondwatermodellering. Water (90) p. 235-240 (In Dutch)
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Figure 2: north-south cross section of model area

We will start by modelling the steady-state drainage of the recharge derived from
precipitation to the rivers. In subsequent steps, the model is made a bit more complicated by
introducing the well (steady state) and then time-dependent (i.e. unsteady state, transient)
groundwater flow.

After having installed MicroFEM, this problem will be solved in the following steps:

1. Making a finite element model network.

2. Assigning some names ("labels") to various groups of nodes.

Entering the hydraulic parameters (using labels) and checking this input interactively.
Entering boundary conditions (recharge, fixed boundaries, well) using the labels and
checking them interactively.

3. Calculating the groundwater flow without well abstraction and obtaining some preliminary
graphical and text results (contour plots, flow vectors, head profiles, cross sections, 3D-
views, water balances).

4. Calculating the groundwater flow with the well abstraction and obtaining graphical results
for that situation (contour plots, head profiles, cross sections, flow vectors, 3D flowlines).

5. Calculating the difference between both situations, which represents the actual effects of

the well abstraction.

Using 3-dimensional flowlines to delineate the well recharge area.

Unsteady-state modelling and visualization of the effects of the well abstraction (contour

plots, time curves).

N
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INSTALLING AND STARTING UP MICROFEM

How to get MicroFEM for Windows (demo version)

Installation of MicroFEM proceeds analogously to many other software for Windows:

1. Download the program from the Internet (http://www.microfem.nl/)
Unzip the setup program using your favorite archiving program (e.g., Winzip,
Powerarchiver, etc.) and save it somewhere.

3. Double click on the setup file and follow the instructions

4. Depending on the Windows version you use you can install MicroFEM just for yourself or
for everyone who uses your computer, too.

5. That'sit! You are now ready to run MicroFEM.

Association of the various MicroFEM file extensions (.FEN, .FEM, .FPR) with MicroFEM in Windows Explorer is
done by the setup program. Thus MicroFEM can be started automatically by double-clicking on a MicroFEM
network- or modelfile name.

Starting up MicroFEM and the MicroFEM GUI

Starting up MicroFEM is easy: just double-click on the MicroFEM desktop icon or use the
Start Menu and select MicroFEM.

First a banner appears (note the version number on the banner) and after a while you will
see the following screen picture (Figure 3).

_ioix]
Files Project Wiew Commands Calculate  Options  Tools  Import  Export  Help
Param
| | ||
e K R R [ . 1 WY ala] <] ElEsl2]

Figure 3: Empty MicroFEM window

(Probably the background of the MicroFEM window will be black. Below is shown how to
change it to e.g., white.)

All buttons on the toolbar are grayed out, because they have no use if no model or network

file is loaded. If you try the pull-down menus on the main menu bar, you'll notice that most
commands are grayed out, too. However, some notable exceptions are:
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= Of course, Help = Help F1 will pop up the online help if the Help file is properly installed.

= Help = Info > About MicroFEM. When you click on this command, a pop-up box
appears with the present version number.

= Options. Here a number of important settings can be changed, e.g., units (meters or feet)
and a number of user preferences like colors (be sure "meters" is selected for this
tutorial). You can save these settings for the next time you run MicroFEM using Options
- Save settings. A rarely used item under the Options command is "Memory", which can
sometimes be helpful if you run into performance problems (see on-line help using the
"Help" button).

= Tools = Time curves. You do not have to have a model loaded in order to display
MicroFEM's proprietary time curve files (these will be treated later), so this option is
always "available".

= Calculate > Edit batch-file. Again, no model needs to be loaded to be able to edit
MicroFEM's batch-files (or, as such batch-files are mere ASCII text files, to edit any
ASCII text file).

Usually, MicroFEM starts up with in a relatively small window. In order to have a better
overview of what you are doing, either maximize this window (click on the open square on
the top right, or double click on the title bar) or drag one of its corners until the window size
fits your needs.

A minimum screen width of about 720 pixels is required to be able to access all buttons on
the toolbar. The Time Curves / Options tab (Figure 59, see page 55) in full needs also about
720 pixels, however, this window supplies slide bars if the actual window width is too small.
All'in all, for easy working a screen resolution of at least 800 (hor.) X 600 (vert.) pixels is
advised; nevertheless, MicroFEM performs happily in good old VGA resolution!

Selecting an other map background color

It is easy to specify a different map background color than the default black. To save ink, this
tutorial makes use of a white map background. In order to specify a different background
color, just proceed as follows:

1. In the main menu, select Options > Map...

2. Click on the Colors tab on the pop-up menu.

3. Inthe menu (Figure 4, next page), select white for the background color (using the drop-
down list) and black for the Drawing color. Leave the other options as they are, and click
on the OK-button.

4. In the main menu, select Options - Save settings.
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& Map options

Drawing mode I Alter-grid mode  Colars I

-~ Background color Colar of lowline per laper:

[ — 3

~Draming color
[ |

—Marking calo

(I —

—Color of circles [- valuezl—

Figure 4: Map options pop-up window, color tab

Once a model is loaded the background color can also be changed as follows. Instead of the
above steps 1 to 4:

Click on the E—button (Drawing mode).
O

2. Right-click on the square with the desired color in the palette E,El‘l‘l‘l‘lll‘_ Now the
screen background will change to that color. The nodes may seem to have disappeared,
depending on their original color. To show the nodes, select a contrasting color as the
foreground color by (left-) clicking on the black square and pressing the F2-key.

3. In the main menu, select Options > Save settings.
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STEP 1: MAKING THE FINITE-ELEMENT NETWORK

A word on network types

MicroFEM offers two ways for making a network (i.e. network generators):

1. Irregular boundary. This generator is most useful if you want to incorporate irregular
(often geographical or geological) phenomena like rivers, lakes, or buried impermeable
rock formations in your model network. On the other hand, with this type it is quite difficult
to build a network where different areas show large contrasts in nodal spacing.

2. Large contrast. This generator is recommended when it is important to obtain areas
where the spacing between nodes is completely different. For example, we often want a
very fine nodal spacing near a building pit and a relatively large nodal spacing towards
the model boundary. However, irregular geographical phenomena are not so easily
incorporated in such a finite-element network.

These network types are sometimes also indicated by the names of the old MicroFem-for-
DOS-programs which were used to make them: FemGirid for the irregular-boundary
networks, FemMesh for the large-contrast ones.

Which network generator type you should choose depends largely on your experience and

on your judgement. Be sure to realize the following:

» Once the network is complete, it can always be changed / refined / adapted in detail at
later stages, even when the model has been calculated. The network generator will
create the initial but ready-for-use, global network for a problem;

» Once the network is complete, all notions of "areas", "segments", "triangles" etc., which
are treated below and which are paramount during the network generation process, are
of no more use at all!l These notions are ONLY required while building a network.

Selecting the network type

Click on the upper menu bar on the keyword File; then click on New Grid in the drop down
list. As in most Windows programs, you can also use hot-keys (press Alt-f and make sure
that New Grid is highlighted in the drop down list, using the vertical arrow keys).

A MicreFEM: 350
| Filez PEroject Yiew

MHew arid...
Open...
Save Al
Save as..
Llear

E it

Figure 5: File > New grid dialog

Next, click on New Grid (or press Enter) and the following pop-up menu appears (Figure 6):
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" Open existing Metwark file with

% Appropriate generatar
= FemfGrid
= Femhiesh

{+ Create Mew grid

" Irregular boundary grid [FermGrid]

% L arge contrast gnd [FermbdeshE

k., Cancel Help

Figure 6: New grid dialog

version 4.10

Make sure the radio buttons "Create new grid" and "Large contrast grid (FemMesh)" are
selected by clicking with the mouse, then click on the OK button. (As in most Windows
programs, you can also use the {-key, Tab-key and Enter-Key to make your choices.)

Another pop-up window appears, similar to Figure 7. Next to the first caption "Model name" a
cursor blinks. Enter some relevant project information here. By pressing the {-key or clicking
on successive lower lines, these lines become white and ready for editing. "Old" text can be

edited after pressing the F2-key.

Project information

todel name

Praject

Location

Drate

Femarks

[mvestigatar

Drate

Femarks

butcriall
MicraFEM tutorial
somewhere

some time

Crate A time of lazt change of this model

Fut all remark.s concerning ta the zpecific modeling steps here;

- current model scenario

- reminders, about special izzues in thiz model and wiy they were
incorporated in this model

- el

Put pour name here

Some other date, perhaps of ztart of modeling project

Put relevant project info here, e.g.:

Project D, project phasze, ...

] ;% Cancel

Figure 7: Information window with example model info
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You are strongly advised to make full use of this information window. Although just a single
alphanumeric character in the upper line will suffice to be able to continue, you are almost
sure to loose track of which model file was made for what purpose as soon as your modeling
project gets more complicated! This information can always be changed or refreshed at later
modeling stages (by means of the Project Command in the Main menu). Just for example,
you can enter the information shown in Figure 7.

Once you have entered all model info and clicked the OK button, the MicroFEM windows
looks like Figure 8:

Eiles Project ¥Yiew Commands Calculate Options Tools Import Export Help

Fixed nodes | Triangles | Quadrangles |

[Ehange number ta | I3 vI

Mo w-coordinate | y-coordinate | spacing
1
2
3

| | I
Xl Dl | '@'l EI Fired nodes | El &> |

Figure 8: Empty network generator window

To the right you'll see a number of columns and some tabs above them (let's call it the "data
window" or “data area”), to the left an empty white (or probably black) area is shown, where
at later stages maps will be drawn ("map area"). The dividing line between the data and map
areas can be shifted by dragging it with the mouse.

For now, just note that at the bottom of the MicroFEM-window there is a row of buttons, one
of them with the grayed-out text "Fixed nodes".

Entering fixed nodes

"Fixed" nodes are nodal points that remain at "fixed" positions throughout the network
generation process (unlike e.g., nodes generated by MicroFEM). All nodes entered explicitly by
the user are fixed nodes. (After grid generation has been completed, these fixed nodes are
indicated with a “label” reading: “fixed node <no.>" to allow easy recovery.) Fixed nodes are used
for:

e Specifying line segments (irregular boundary network, not used in this tutorial);

e Specifying the corners of triangles and/or quadrangles (large contrast network);

e Specifying e.g., well locations.

In our model network we would like to incorporate the following phenomena:

e The rivers along the northern and southern boundaries;

The well;

The location of the landfill, provisionally with just one node;

Additionally, we would like to have a much smaller network spacing near the well and to a
lesser extent, near the landfill, than near the model boundaries.
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The shape of our model area is a simple rectangle. However, to be able to have the variable
network spacing generated automatically, the well and the landfill node have to be part of the
network setup. For this problem, the landfill is represented by a single fixed node.

We set up the network by connecting the well and the landfill with a line and drawing lines
from the well and the landfill location to the nearest boundary (see figure 8). This way we
obtain 6 quadrangles and 12 points where two or more lines intersect — such points must
always be fixed nodes. (Admittedly, we could make the network also by using just six triangles and
six nodes, but the example problem just works like this).

Next, we number the fixed nodes, the triangles and the quadrangles (Figure 9).

1 2 3 4
A B
11 c
10
F 12 5
E D
9 8 7 6

Figure 9: Overview of model network setup

We'll start by specifying the number of fixed nodes. In the right part of the MicroFEM window
(data area) we make sure that the "Fixed nodes" tab is selected (if not, either click on it, or
press the Tab-key until the current tab is highlighted, then use the arrow buttons to select the
Fixed nodes tab).

Click on the up-arrows until the number of nodes shows "12", or, use the Tab-key until the
number of nodes, i.e., "3", is highlighted and then use the vertical arrow keys to increase the
number to "12" (or simply enter a "12" from the keyboard).

To finalize this step, click on the "Change number" button.

Now we are ready to specify the locations of the fixed nodes. This can be done simply by first
clicking twice on the upper leftmost column/row cell and then entering the value of the
coordinates. By tapping the Enter-key, focus shifts to the next cell automatically. In case you
made a typo, simply use the arrow keys or the mouse to move the focus to the erroneous cell
and then press the Enter-key to start editing.

In this example all coordinates have been specified in meters. In case you prefer feet rather
than meters you are free to do so (see page 7).

The origin of the coordinate system can be chosen freely. If you use a local coordinate
system, as in our example, the origin is often chosen at the lower-left (south-west) boundary.

In addition to the fixed nodes coordinates, we also have to enter a "spacing". This is the
network spacing (i.e., the distance between two neighbouring nodes) around the fixed node
in question. Around the well we request a spacing of 50 m. At the landfill location, where the
changes of head gradients and flow directions are probably much smaller than around the
well, a larger spacing of 100 to 150 m will suffice. In order to remain within the capacity limits
of the MicroFEM demo version (which has a maximum of 2500 nodes), we have to
experiment a bit, to finally obtain an optimal spacing at the boundary nodes of 225 m and
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around the landfill of 140 m. In the next steps, you will see how this experimenting can be
done. You can (and are encouraged to) optimize even further until the maximum allowable
number of nodes of 2500 for the demo version is almost completely used.

In the end, when all coordinates and spacings have been entered, at the bottom of the
MicroFEM window the text on the button "Fixed nodes" appears. Click on this button, and
you'll see the fixed nodes lay-out appear in the map window (Figure 10).

Filez  Project “iew Commands Calculate Options Toole Import Export Help
Fized nodes | Triangles | Quadrangles |
[t |[12 3
Ma w-coardinate Iy-c-:u:-rdinate Ispacing |
1 ] G000 225
2 3000 BO00 225
* 3 5000 £000 225
4 10000 EO00 225
5 10000 2000 225
B 10000 1] 225
7 5000 1] 225
2 3000 1] 225
9 i] 1] 225
10 i] 4000 225
11 2000 4000
M | 12rodes | 5 | %= 1000000 y = 2000.00 12 [5000 2000 o0
Xl Dll@l @I Nodesonsegmentsl El ;{>>| il |e\| +ﬁ| 4{+| @llgl%l

Figure 10: All fixed node data entered

The text on the button will change after clicking on it, indicating that MicroFEM is ready for
the next step. However, in case you are not satisfied with the results, you can simply edit the
values in the fixed node list, or even specify another number of nodes. The “Fixed nodes”
text will reappear as soon as all information has been entered.

Note that initially, the node in the lower left is blinking. But as soon as you click on a node in
the map window, a cell of the corresponding node is highlighted in the columns to the right.
The other way round works too: click at a cell in the columns, and the corresponding node in
the map starts blinking. For example, in Figure 10, fixed node no. 11 is highlighted and
blinking. In addition, once all fixed node data are entered and in all ensuing steps, you can
use the following buttons at the right bottom of the screen:

Zooming in, the mouse cursor location (current node) will be centered in the map
window

L L2

Zooming out

e,
i

=t Zooming in on a selected area. After clicking once on this “zoom area” button, new
map boundaries can be "dragged"” in the map window; when the mouse button is
released the map window is zoomed in. As the selected map boundaries in most
cases won't have the same length/height ratio as the MicroFEM window map screen,
MicroFEM zooms in so that at least the entire selected map boundaries are shown.

Il' Be aware of the fact that this button will remain active until you click on it again! (or
another zoom button is clicked). If this tool is still active and you click in the map
window, this will be interpreted as a very small new map window and MicroFEM will
zoom in until just one node is visible! (You can undo such an unwanted zoom action by
right-clicking in the map window and then selecting "Previous view" (works only for the last
zoom action; BTW in MicroFEM versions prior to 3.60 this was called "Zoom out"), or you can
select "Fit to scale" to see the entire model).

I_'il Shift the map in any desired direction (panning)
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This offers a very powerful and convenient way to check the lay-out and numbering of the
fixed nodes. By the way, note that the text on the button "Fixed nodes" will have changed
into a grayed out "Nodes on segments".

Entering the rest of the network data

Next the number of triangles (0) and quadrangles (6) must be specified. This works similarly
to specifying the number of fixed nodes, just the tab is different.

Once the number of quadrangles is entered, we have to specify which nodes make up which
quadrangle. In Figure 11, all this information has been entered for quadrangles 1 to 6, which
correspond to quadrangles A to F in Figure 9. For your info: you have now entered all the
information needed for the network build-up. MicroFEM does the rest!

Filez Project “iew Commands Calculate Ophons Tools  Import Export Help
Fited nodes | Triangles Quadrangles I
T I PR Change number o ||5 3]
No [Node1 [Node2 [Mode3 [Woded |
1 1 2 11 10
2 2 3 12 11
3 3 4 5 12
4 ] =] T 12
5 7 2 11 12
53 8 &l 10 1)
1 | 2#5nodes | 7| % =5000.00 y = 0.00
xoee H Eemerts | || £ 0| 2] aje | ¢| ElEl ]

Figure 11: All network data complete

As soon as all the information on the quadrangles has been entered, the grayed-out "Nodes
on segments" button appears in full. Click on it, MicroFEM generates and draws new nodes
on the lines connecting the fixed nodes and the text on the button changes into "Nodes in
regions". Once the segments have been drawn, clicking somewhere in the line defining the
quadrangle node numbers will highlight the corresponding quadrangle in a yellow color in the
map window to the left (the other way round, clicking inside a quadrangle in the map window,
does not work).

Again click on the large button (which now shows the text “’Nodes in regions). A window
similar to Figure 11 (above) appears. The increasing number of nodes is continuously
displayed on the status line, together with the node number nearest to the cursor, and its
coordinates.

The text on the large button has now changed into "Elements". Just click on it and then the
elements are generated, starting at the boundary and proceeding counter-clockwise.

When the elements are displayed, individual triangles and quadrangles can be recognised in
the network by yellow lines, by clicking cells in the respective tables.

In succeeding steps, the button text changes into "Relax grid" and "Renumber nodes". Relax
grid means that all nodes generated automatically by MicroFEM in the quadrangles (i.e., not
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the fixed nodes whose locations you have entered, nor the nodes on the lines connecting all
fixed nodes) are moved into a new position exactly in the middle of all their neighbouring
nodes. As these neighbouring nodes are also moved, this step proceeds iteratively. The
result is a network where acute and obtuse element angles are avoided as much as possible.
Elements should be more or less equilateral to reduce numerical errors of the finite-element
approximation. So, have MicroFEM relax your network.

The Renumbering nodes step is also recommended, but not as much as the Relax-step. The
original numbering of nodes will be replaced by a more or less overall numbering from one
side of the model to the other. Afterwards, adjacent nodes will have more or less "adjacent"
node numbers. Renumbering has no effect on the (accuracy of) the computations.

In case you are afraid you'll loose track of the node numbers used for network generation,
don't worry, they are preserved somewhere (see p. 19).

The result of all these steps is the network shown in Figure 12.
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Figure 12: Complete finite element network

Elg] 2

For the sake of completeness we'll have a closer look at the buttons at the bottom of the
MicroFEM window. From left to right these are (Figure 12):

.ﬁi Can be used for erasing all entered network data from MicroFEM and returning to the
empty MicroFEM window as in Figure 3.

@ Clears all just entered network data.
Enters all required input data for an example of a high-contrast network.
kel

Enters all required input data for a hexagon network, to be built with the large-contrast
boundary network generator. MicroFEM will ask for size, position and node spacing
and fill in the rest for you, so this can be used as an easy starting point for many civil
engineering applications.
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@ (Not in Large contrast network generator, only in Irregular boundary network
generator). Read fixed node coordinates data from an ASCII file.

@l Insert a node, triangle, quadrangle, segment or region, depending on which tab in the
data area is active.

EI Save a network data file, which contains all entered data in the lists, and, only in the
case that a network has been generated completely, additionally the network data
itself.

A2 Switches from network mode into model mode.

Before continuing to model mode, it is advisable to save the network data to a file:

Press the El-button and, in the ensuing file-pop-up window, save the data as a Network
(.fen) file in a directory of your choice. Note that the default name suggested by MicroFEM
comes from the text on the first line of the model information window ("Model name").

BTW If you do not save it by yourself, MicroFEM will remind you with a pop-up window to
save a .fen file.
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STEP 2: MAKING A MODEL FROM THE NETWORK

We are now ready to develop our 2D-network into a 3D model by adding the vertical dimen-
sion. Just press the i_>>!—button and the following pop-up window appears (Figure 13):

M Aguiters -0 x|

Humber of aguifers -

] Cancel |

Figure 13: Number of aquifers window

The default number of aquifers (one) is right for our tutorial problem. Just click on the OK-
button or press Enter, and MicroFEM switches into "model" mode (Figure 14):

Filez  Project “iew Commands Calculate Options Toolz  Import Export Help

Param |

0 |head [m] §0.000

1 |wert res. [d]|D
tranz. [mEsd] |0
head [m] | 0.000
dizcharge [né/d] |0

El
1404 | 1:1E5 | 233 | % =8114.09 y=1429.44 label 1 |
| | eleed ] o] leal [ |- aef &l ¢z AlSI®|

Figure 14: MicroFEM model window, Walking mode

In Figure 14 the following parts can be designated:

e The map area to the left, where a finite element network is displayed

e The data area to the right, showing a list of hydraulic parameters and boundary
conditions (see later). Note that at the lower part a gray bar with the text "label 1" has
appeared; strictly speaking, this is also part of the data area

e The button toolbar, with some new buttons at the left and extreme right and zoom/pan-
buttons at the right side

e The status bar above the button toolbar

Intermezzo: An overview of MicroFEM “modes”

On the lower right of the MicroFEM window four new buttons have appeared, each referring
to a particular mode of MicroFEM. These modes are defined as follows:

i (mode 1) Walking mode. Used for moving around in the network, marking / unmarking
nodes and computing water balances.
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& (mode 2) Input mode. Used for entering hydraulic parameters, heads, boundary
conditions and saving / loading parameter files (see later).

EI (mode 3) Drawing mode. Used for drawing contour maps, (parts of) the nodes or
network in user-specified colors, flowlines, cross sections, head profiles, etc.

ﬁl (mode 4) Network mode. Used for adaptation of the finite element network, like
adding / deleting nodes, swapping node connections, optimizing the network, and
adding / deleting aquifers & aquitards.

When starting up MicroFEM, or when a model or network file has just been read, MicroFEM
is by default set to mode 1, the walking mode.

MicroFEM model screen (Walking mode)

The map window
Be sure MicroFEM is in Walking mode: click on the ﬂ-button.

In the centre of the map area in Figure 14 a small white "hole" is shown in this document. In
the real MicroFEM window this hole is blinking. When you zoom in on it (the zoom buttons are
the same as in network generation, see p. 13), you will notice that this blinking hole is actually a
blinking node of the finite element network. This blinking node is called the "current" node.
The hydraulic parameters and boundary conditions (e.g., well abstraction, fixed head or fixed
flux) of this node are shown in the data window to the right.
In the status bar below the actual map area, from left to right the following information is
shown (example of Figure 14):
1404 The node number of this current node
1:1E5 The drawing scale of the map (in this case 1:100,000). Admittedly this scale depends
on the monitor size, but it is a good approximation for bitmaps exported to the
clipboard and printer
2335 The node number of the node that happens to be nearest to the mouse cursor
x=8104.09, y=1429.44
These are the X- and Y-coordinates of the node that is the nearest to the mouse

cursor. However, when the “zoom area” button & is pressed, the X- and Y-
coordinates of the mouse cursor are displayed.

When you move the mouse cursor over the finite element network drawing you will see that
the information of the latter two items is continuously updated. In case the mouse cursor
leaves the model network, the information pertaining to the node currently nearest to the
mouse cursor is shown on the status bar. If the mouse cursor leaves the map area, the
coordinates are hidden.

The parameter list

In the data window on the right you will see the word "param" at the top. Note that this is
actually on a "tab". In later sections you will see that other lists can be added, showing tabs
like "top", "thick", etc.

In the "Param"-list, you will see from top to bottom:

0 head [m] 0.000

1 vert.res. [d] O
trans. [m2/d] O
head [m] O

discharge [m3/d] 0.000
There is a head at the top of the list: h0. For each layer with horizontal flow in the model
(usually an aquifer) three to four parameters have to be specified. The vertical hydraulic
resistance for flow to the overlying layer (usually through an overlying aquitard) is defined by
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Cn, the transmissivity of the layer by t,,, the computed or to be computed head in the layer by
h, and the discharge abstracted from this node q,. For the first layer (aquifer) these
parameters are labelled ¢1, t1, h1 and q1. Layers are counted from the surface downward,
with the upper layer always as no. 1.

The condition at the top of the model is by default an impermeable boundary. The
parameters that are used to specify this condition are a fixed level h0 and a resistance ¢1:,
as follows:

¢ hO is the fixed potential of a head-dependent (leaky) top-boundary, for example the fixed
groundwater level in (or above) a semi-permeable covering layer. It is expressed as a
height above a certain reference level. The reference level is usually implicitly taken as
the national reference level, or the height above mean sea level (MSL), but may be any
level desired by the user. Obviously, this reference level must be the same for all nodes,
heads and levels in the model.

o c1is the vertical hydraulic resistance of a head-dependent (leaky) top-boundary
condition. Note that in MicroFEM an infinite resistance is entered as a zero value. Since
there is no leakage to fully confined and unconfined aquifers, the head-dependent
boundary condition is put out of action by assigning a zero resistance (¢1=0) to the
relevant nodes — this is the default case. In such a case hO is irrelevant for those nodes.
If and where a non-zero vertical hydraulic resistance is entered, the upper aquifer is leaky
(semi-confined) and the vertical inflow rate will be computed as (h0-h1)/abs(c1), where
abs(c1) means the absolute value of c1.

Now, just click on the southeast corner point of the network, the one that was entered as no.
6 when the network was designed. On the left side of the status bar the number of the
current node is displayed. But at the bottom of the data window, in the gray cell next to label
1, the text "fixed node 6" has appeared. This "fixed node 6" is simply a name assigned to this
node (and has nothing to do with “fixed heads nodes” as outlined on page 27). You can assign any
name to any node or group of nodes. Moreover, one and the same node can have up to five
names. Such names (labels) can have many purposes in MicroFEM, e.g. the marking or
selection of nodes, as you will see later. (In MicroFEM "marking" and “selecting” mean the
same thing.)

The reason that node 6 is called "fixed node 6" is simply that MicroFEM assigns similar
names to all nodes you have entered during the network generation process, as an aid to
allow you to identify these nodes in the model network.

Efficiently assigning values and boundary conditions

In order to avoid having to assign values or boundary condition types to each individual node
in turn, groundwater models have to make use of mechanisms to assign values to groups of
nodes in a practical way. MicroFEM has a two-stage process for this:

1. A number of nodes (e.g. on a line or within an area) can be "marked" (selected). This
marking of nodes is only required to specify the area (the nodes) for a subsequent action.

Nodes can be marked interactively either one by one, along a line or in some area.
A powerful way to quickly select nodes for marking is to make use of "labels". Each node
can have a number of names ("labels"). MicroFEM supplies tools for marking nodes
whose names comply to certain (user-specified) conditions.
2. Values or boundary conditions can be assigned to all "marked nodes" at once.
Assigning values in one step to a number of marked nodes, does not necessarily mean that
the same value is assigned. One can also use formulas containing variables and/or

parameters both having different values for individual nodes
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In addition, marked nodes serve for delimiting contour drawing and can also be used for
adding or deleting nodes in network mode.

A very big advantage of using labels and marks is that values etc. can be assigned to several
non-contiguous areas in one action, and that these areas are "saved" with the model more or
less implicitly.

Marking river nodes

We will start with assigning names to the rivers by marking the river nodes and then

assigning names to them.

1. Go to Walking mode: click on the il—button.

2. Now either click on the ﬁ-button, press the F10-key or select Command - Automarker
from the main menu.

3. Click on one of the corner nodes (in this case, all corner nodes are river nodes).

You now have "marked" or “selected” this corner node. To indicate that this is a marked
node, its number on the status bar is placed in a yellow box (see Figure 15):

- "'.. AR N T % K L [ =
A A A ! 7 T,
.,'ﬁh‘nuvmvmﬂ'ﬁ'ﬁhﬂnﬂ#‘rﬂﬂ AT
A s AWM Y WAL A WA T P i
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B9 | 115 | e; | #=0.00 y=0.00
0 R R R el 1

Figure 15: Example of status bar indicating a marked node

You'll notice that MicroFEM indicates that the node nearest to the mouse cursor is also a
marked node. In this case the mouse cursor (not shown on the picture) happened to be at
the current node.

To undo the marking of a single node, just be sure that the ﬁl—button is pressed and then
right click on the node you want to unmark (deselect).

Of course you can now proceed to mark all river nodes. Keep the left mouse button down,
and move it carefully along all the river nodes you want to mark. When one side of the model
is marked, do the same thing for the other river.

Click again on the Automarker button g to deactivate it.

Alternatively you can use the “line marker” tool.
1. Toremove all marks, simply press the _|-button (Delete marks) or use the Del-key

2. Pressthe _|-button to activate the Line marker. Alternatively you can use the F11-key or
select Command - Line marker from the Main menu to toggle (switch on or off) this
function.

3. Click on one of the corner nodes.

4. Click on the opposite other corner node of the same river. You will see that all node
connections of the river will turn yellow.

5. Click twice on the _|-button to switch it off temporarily.
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6. Click on a corner node of the other river

7. Click on the opposite other corner node of the same river. You will see that all node
connections of the other river will turn yellow too.

8. Click once more on the __I-button to switch it off (do not forget!).

N.B. If you had forgotten to temporarily inactivate the Line marker tool (step 5), all nodes between the first
river and the first corner node of the other river would inadvertently have been marked, too.

There is no direct way to undo a line marked with the line marker. The best way out is to toggle all marks (F9-
key), to mark the line in question with the Line marker, and to toggle all marks again (F9-key).

Now both rivers have been marked. All connection lines between two adjacent nodes are
yellow, clearly indicating the rivers.

Assigning names to the river nodes

1. Locate the gl—button (Input mode) and click on it, or press Alt-2. You are now in Input-
mode.

2. Click on the cell to the right of "label 1" at the bottom of the data window. This cell will
then be selected (blue).

3. Click once more on the same cell to open it for input. The cell turns white, while the
selected text is blue.
Enter the word "river" (without quotes)

Click on the M—button (Marked nodes) or press the F3-key.

Now all marked nodes (both rivers) are called "river" in the label 1-field. By using the "Marked
nodes"-button the specified name is assigned to the marked nodes only.

You might have noted that the @l-button, which was grayed out initially, now has turned into

red (@). This is the "Undo"-button — it allows you to undo only the last assignment you
made. When you press this button, all values will be restored to what they were before the
last assignment, and the Undo-button will be grayed out again.

As you'll guess, there are also tools to assign to non-marked nodes (ﬂ or F4) and to all

nodes, regardless of marking state (QI or F5). Another tool is the El-button, which you can
use in an unmarked area completely surrounded by marked nodes; it will assign the value to

all unmarked nodes in the area. The El—button works the same and also assigns the value
to the marked nodes immediately bordering the unmarked area.
Intermezzo: Removing marks

To remove all marks, simply press the _|-button (Delete marks) in either Walking or Input
mode.

If you want to remove just some node markings, you can use the Automarker tool (ﬂ) and
either right click all unwanted node individually, or —keeping the right mouse button
depressed- drag the mouse cursor over the nodes in question.

Sometimes the following trick comes in handy:

1. Go to Walking mode and click on the _|-button (Toggle all marks). All marked nodes will
now be unmarked and all unmarked nodes become marked. On the screen you will see
that the larger part of the model network will become yellow.

2. Now use the marker tools (il or _I-buttons) to mark the nodes you actually wanted to
unmark (note that you are working in a sort of reverse-marks situation).

3. Again click on the J—button to restore the proper situation.
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Checking that all river nodes have the same label name
There is an easy way to check the input of names:

1. Go to Drawing mode by either clicking on the El—button, pressing the Alt-3 keys, or
selecting View - Drawing mode from the main menu. The map window will be erased

and only the nodes will be shown.
_ _ CEEEEETE _
2. Select a suitable color on the toolbar in the palette =M™ "F MM  for instance bright

red.
3. Pressthe button (Draw contours) or press F7.

4. You will first see the following pop-up window (Figure 16):
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Figure 16: Contour pop-up window (1)
Simply click on the OK-button or press the Enter-key.

5. The resultis a map as in Figure 17:

Figure 17: Contour map of label 1

Since labels are no continuous numeric parameter, MicroFEM will draw "contours" between
all adjacent nodes with different "values" or names.

You can easily check that the uppermost and lowermost row of nodes along the boundaries
have the same "value" or name. If you just click on one of those nodes you will see that it has
the name "river" (without quotes). Consequently, you can conclude that all river nodes have
the proper name.

You might wonder why there are some small circles elsewhere in the model. But when you
click on them you will see that these still bear names like "fixed node ...".

Intermezzo: removing contour drawings
If you do a lot of input checks using contour maps, the map picture may get clobbered up
severely. To remove unwanted contour plots, simply proceed as follows:
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1. In the main menu, select “Options” 2> “Map ...".
2. In the pop-up window, select the unwanted “Drawing component” and then press the
Delete button.

This way, any unwanted drawing component can be deleted.

Assign names to the landfill and the well

By now you know how to assign label names, but another issue appears: How can one
quickly "go" to the node where the well is located?

Here is the solution: Remember that the well and the landfill have been given names (by the
network generator) of "fixed node 12" and "fixed node 11", respectively. MicroFEM allows
one to quickly "jump" to a node with a certain name.

1. Go to Walking mode (click the il—button).
2. Click once on the cell to the right of the text "label 1", in order to select that label.

3. Click on the ﬂ-button (Jump to node) or press F12. A pop-up window appears (Figure
18):

Jump: Yo node

Jump
= Mumber
% hext label Close
= Mext wel
Mode label : Help
fixed node 12 j

L {fiwed node 10 |—

—di o oA A

Figure 18: "Jump-to" pop-up window

4. Because of step 2, the "Next label" radio button will be selected. (Would you have clicked
on a cell next to “discharge” higher in the data window in step 1., the “Next well” radio button
would have been selected; clicking any other parameter would have selected “Number”.)
Press the small black triangle and select "fixed node 12" in the pull-down list.

Click on the "Jump"-button.

Click on the "Close"-button.

No o

The current node has moved to the well node (the text "fixed node 12" appears in the label 1
field). You can now enter a proper name for it:

1. Go to Input mode (click on the @-button)

2. Make sure that label 1 is the active parameter (if needed click in the cell to the right of the
"label 1"-text to select it)

3. Press the Enter-key to open the cell. The dark blue background becomes white.

4. Enter the word "well" (without quotes) and press the Enter-key.

Done!

It is left to the reader to assign the name "landfill" to the landfill node.
NB: MicroFEM does not only allow you to jump to a node with a certain name, but also to a

node with a specific node number, or to a well in the selected aquifer. See the on-line Help
for full details.
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Using formulas and parameter values

In MicroFEM, numerical input does not necessarily need to be numbers. In virtually all cases
where numeric input is required, MicroFEM actually invokes a formula interpreter (which -
-obviously- has no problems with just plain numbers). In the sequel, frequent use is made of
this mechanism.

¢ As operators MicroFEM recognizes +, -, *, / and * (power). Use pairs of parentheses "("
and ")" for precedence of operation. Various standard mathematical functions, like abs(),
sin() and exp(), are also recognized.

¢ Built-in variables comprise r (distance from current node), d (distance to nearest marked
node), p (present value of selected parameter), a (nodal area) and many more.
Parameters can be e.g., h1 (head in aquifer 1), t1 (transmissivity of aquifer 1), ¢5
(vertical hydraulic conductivity of the aquitard overlying aquifer 5, if present).

¢ MicroFEM always expects a "." (period) as decimal separator, independent of your
computer's locale settings.

See the on-line HELP system (section: “Using formulas”) for more information and a
complete list of all functions, variables and parameters.

Entering hydraulic parameter values

We are now ready to fill the model with hydraulic parameters.
Locate the B-button and click on it. You are now in Input-mode, which is also shown by the
blue color of the active parameter cell.

Vertical hydraulic conductivity of the covering layer

First of all, we are dealing with an unconfined aquifer. This implies that there is a given
recharge by precipitation. There is no head-dependent recharge at the top of the aquifer. To
prevent such flow, the top must be modeled as a no-flow boundary. An impermeable aquitard
is obtained in MicroFEM by assigning a zero value to the vertical resistance c1. Although this
is the default value for a vertical resistance whenever a newly made model network is loaded
or a new aquifer is added, we will assign this value to the covering layer just to be sure.

1. Click on any node in the map window.

2. Click on the cell to the right of "vert.res. [d]" in the data window. Click once more on the
same cell to open it. This cell now gets a white background. As the number in it is
probably 0 (zero), you won't have to edit it.

If you just press the Enter-key, the value of 0 is only assigned to the vertical hydraulic
resistance of the covering layer of the current node. This is not what we want. In that
case, press the Enter-key again to open the cell again.

3. Click on the Ql-button somewhere left on the toolbar, or press the F5-key (All nodes).
After you've done this, all nodes of the model now have the same value of 0 (zero)
assigned.

You might note that the @l-button, which was grayed out initially, now has turned into red

(@). This button is the "Undo"-button — it allows you to undo the /ast assignment you made.
Once you have pressed this button, all values have been restored to what they were before
the last assignment, and the Undo-button will be grayed out again.
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Check on proper values for the vertical hydraulic resistance

If you want to be sure that all nodes have the same vertical resistance, you can try to draw a
contour map of this parameter. Refer to the "Checking that all river nodes have the same
label name™section (page 22) on how to draw contours, but be sure to select c1 (vert. res.)
as the current parameter. Since all nodal values are the same, a contour map cannot be
drawn; MicroFEM responds with a message: ‘constant value’. Just press the OK button.

(Initial) transmissivity of the aquifer

MicroFEM needs transmissivity values rather than hydraulic conductivities. As we are dealing
with an unconfined aquifer, which has a mound between the rivers (due to the recharge by
precipitation and drainage to the rivers), we do not know the actual aquifer thickness yet.

In order to cope with unconfined aquifers, MicroFEM has a built-in automatic procedure.
However, to use this we need to work with a so-called batch-file. Since we want to postpone
the use of that for a later stage, we will compute the actual thickness with a step-by-step
(iterative) procedure.

To start with, we simply multiply the hydraulic conductivity of 12 m/d by the thickness of the
aquifer at the location of the rivers. The rivers are supposed to be fully penetrating and so
they reach 35 m into the aquifer from water level to river bottom. Consequently, the thickness
here is 35 m and the transmissivity equals 35 m X 12 m/d = 420 m?/d at the river nodes. We
simply assign this initial value to the transmissivity of ALL nodes:

1. To be sure we are in Input mode, press Alt-2
2. Click on any node in the map area
3. Double-click on the transmissivity value cell in the data window

4. Enter 12 * 35 for the transmissivity value and leave it at that, do not press any other
button (the cell background must still be white)

5. Click on the gl—button or press F5. The transmissivity cell now has a dark blue
background. As you can see, MicroFEM simply evaluated the formula you entered and
assigned the outcome to all nodes.

By the way: MicroFEM behaves much like a spreadsheet when you use formulas: first it
copies all formulas to the selected nodes and only then evaluates them, rather than that it
evaluates the formula and then assigns the computed result to all nodes.

You can check the assignment by drawing a contour map of the first aquifer transmissivity
along the lines sketched on page 22 ("Checking that all river nodes have the same label
name").

Assigning boundary conditions

Top boundary condition

The top boundary condition type (no-flow) has been entered by specifying an impermeable
covering layer. We need to complete this for an unconfined aquifer by specifying the fixed
flux across this boundary, i.e. the recharge from precipitation.

In order to specify recharge from precipitation, we have two options:

1. Specify the flux as a negative abstraction in the upper aquifer nodes, which is linearly

related to the nodal area
2. Use a dedicated top system type for it.
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Although the first method is deprecated now, it can still be useful in case of a more complex
top boundary conditions. In our case, we will use the "precipitation" top system.

1. Click on the main menu on Project > Project manager. You'll see the following pop-up
window (Figure 19):

# Project manager =] B3
Unit Save Help

Ease mu:u:lel tut-:urlaH fem I: 'xD u:u:uments anu:l 53tt|ﬂg3"«phl|lp"xh‘1l|n ducumenten'\.prcqecten"xh*l||:r|:|FEM"-.vEI 4'&
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Figure 19: Project manager pop-up window (1)

2. Click on the El—button (Add to project). Now the following pop-up menu appears (Figure
20):

Add toiproject

_'é'dd unii" .............................

" Thickness ¥ Precipitatior:

" Anizobiopy " Dirain system

™ Storativity " Riiver spstem

" Labels " Evapaoration system

" S worksheet " WWadirecharge system
Create data from:

" File " Mew

k. Cancel Help |

Figure 20: Program manager, Add unit menu

3. Select "Precipitation" and make sure that this unit is created "new" (see Figure 20).

4. Click on the OK-button. The Project Manager main window reappears. Just check here
that indeed a so-called "unit" has been added to the model project. We will have a closer
look at the Project Manager later. For now, just close the Project Manager main window
(which will now look like Figure 21):
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Figure 21: Project manager pop-up window (2)

5. In MicroFEM’s data window a "Top" tab will be created (Figure 22):

F'araml Top |
0 |head [rn] {0000
1 lwert res [Afrin

Figure 22: Data window with new top system

6. Click on the new "Top" tab to see the topsystem list. The data window will look similar to
Figure 23:

Param Top |
Frecipitation  [m.d] IEI.24 /365,24

Figure 23: Top system tab

7. Double-click on the value field next to "Precipitation [m/d]" and enter the daily
precipitation. Type the formula 0.24 / 365.24 (just leave the input at that, see Figure 23)

and press the [ button or F5 (All nodes). Remember, the annual precipitation was
specified as 240 mm and we need to enter a daily value in meters.

Lateral boundary conditions

We now will enter the lateral boundary conditions.

The rivers have water levels of 35 m above the base of the aquifer. These levels are
assumed independent of the groundwater flow in the model area; in other words, they can be
taken as fixed levels. In model terms, they constitute fixed-head boundary conditions.

The eastern and western boundaries are assumed to lie along a flowline and will be
considered impermeable (no-flow boundaries).

It is important to realize that there are two types of boundary conditions for lateral flow:
1 Fixed-head (also called: given head, specified head or Dirichlet) condition. In this case
MicroFEM will compute the boundary flux.
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2 Specified flux (also called: specified flow, given flux or Neumann) condition. In this case
MicroFEM will compute the head.

All along the model boundary (i.e. for each boundary node, in each layer with horizontal flow)
one of these two lateral boundary conditions must be specified. By default, all nodes have
the second boundary condition (head will be computed by MicroFEM) with a default zero
boundary flux (no-flow boundary). This implies that the eastern and western boundaries
already have the proper type of boundary condition for the aquifer nodes.

In MicroFEM a fixed-head boundary condition can be specified anywhere in the model area,
be it on the lateral boundary or somewhere inside the model area.

While the assignment of hydraulic parameters to all nodes in one swoop was an easy job, we
now have to specify the boundary condition to a subset of the nodes. We will again use node
"marks" to do this quickly and efficiently.

Boundary condition type for the river nodes
To mark the river nodes in aquifer 1 as fixed-head:

1. First remove all marks, to be sure that the fixed heads are not inadvertedly assigned to
wrong nodes: in either Walking or Input mode, simply press the _l-button (Delete

marks) or press Del. Next, make sure the network is redrawn by clicking on the __i-
button (Draw grid) or pressing the Ins-key in either Walking mode or Input mode. Also
click once on the Param tab to return to the aquifer parameter list.

2. Mark the river nodes. Go to Input mode (if required click on the gl—button) and then
click on the label 1 cell to make label 1 the active parameter.

3. Click on the ﬂ-button or press F2 (Mark data or labels). A pop-up menu appears
(Figure 24). (If it mentions values rather than labels, you probably forgot to first select
label 1 as the active parameter.)

Mark Iabelz
] 4
Enter a label:
= Cancel
fired node 10
fimed node & Help
landfill

Figure 24: Mark data or labels pop-up menu

4. Make sure that the label name "river" is selected by using the drop-down list (see Figure
24), and click on the OK button. You'll notice that the river nodes will now be marked.

5. Click on the value cell next to "head [m]" in aquifer 1 (h1).
6. Click on the El—button (Fixed heads for marked nodes) or press the F9-key, to assign a
boundary condition type of “fixed head” to all marked nodes: in this case for all river

nodes.

When the current node is at the river boundary, the word “fixed” is added next to “head” in
the parameter list, indicating that the current node has a fixed head in aquifer 1.
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Check on boundary condition types

Many modelling errors are made because a wrong boundary condition type has been
entered somewhere in a model. Sometimes such errors can be hard to find. In MicroFEM
one can use an easy procedure for finding out which nodes are fixed-heads:

1. Go to Walking mode (click on theil—button).

2. Remove all marks: click on the _‘-button (Remove all marks) or press the Del-key.

3. Make sure the head of the aquifer (or the head of the relevant aquifer in multi-aquifer
models) is selected: click on the value-cell of (in this case) h1.

4. Go to Input mode: click on the gl—button.

Click on the ;'.I-button (Mark nodes with fixed heads) or press the F10-key. Only the
fixed heads will now be marked.

6. To show the fixed nodes, you can:

a) Go to Walking mode (ﬂ-button or Alt-1), then click on the il—button (Blink marks)
or press the F6-key. The marked (and fixed) nodes will be blinking, usually enabling a
more rapid recognition, and/or:

b) Go to Drawing mode and press the ﬂ-button (Clear graph) or press the Del-key,

then either press the _|-button (Draw marked nodes) or press F3. In case of
adjacent marked nodes (e.g., along a fixed-head boundary), it may help to check if
really all nodes of a line of nodes have fixed heads by also drawing the connections

between marked nodes by clicking the Ql—button (Connect marked nodes) or
pressing F4. If one or more nodes were forgotten, they show up because the
otherwise continuous line will be interrupted around the node(s) in question.

Boundary condition value for the river nodes

This step is an easy one. We start off with a head of 35 m for all nodes. Actually only the

river nodes have a specified head value of 35 m; all other heads will be calculated. However,

it is convenient to just assign the same value for all nodes. The computed heads will be

found, irrespective of the entered values.

1. Click on the value cell of h1, to highlight it (it was probably selected anyway from the last
step)

Make sure we are in Input mode (click the ﬂ-button)

2.
3. Enter a value of 35

Press the gl-button (All nodes), or press the F5-key.
Done!

Saving the model
We are now ready to calculate the model for the first time. However, it is wise to save our
work first.

This is very easily done by clicking on the main menu on File > Save All.

You'll probably see a pop-up file window (if not, you have saved all data earlier; MicroFEM
then "knows" all needed file names and simply overwrites the files on disk with the newer
versions). If needed, navigate to a directory where you want to store your model (maybe the
same as where you saved the network fen-file), then save all units associated with the
model, i.e. your base-model unit (fem-file) and your precipitation unit (ppn-file).
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STEP 3: CALCULATING THE MODEL IN STEADY
STATE WITHOUT WELL ABSTRACTION

We will now calculate the model in steady state, without well abstraction, and model the
groundwater mound between the rivers that is due to recharge from precipitation. A problem
here is that, since the groundwater level is unknown, we do not know the saturated thickness
of the aquifer and so we cannot enter the transmissivity.

Manual calculation of the groundwater table

As said before, we will first show how unconfined conditions can be computed manually. This
proceeds as follows:

a) We assign an initial transmissivity of h1 * 12 (m%d). As we have already entered an initial
head of 35 m and an initial transmissivity of 12 * 35 = 420 m?d to all nodes, we can skip
this first step. Note that in this case the head h1 is the same as the aquifer thickness,
since our reference level is chosen at the base of the aquifer. In cases with a less
convenient reference level, sloping or discontinuous aquifer bottoms and/or perhaps
impermeable clay lenses, the initial aquifer thickness will have to be taken into account
much more explicitly.

b) We calculate the model heads, based on the entered transmissivities that are only
approximately right. The highest computed heads will be good indicators of the degree of
correctness of the manual iterations: if in two consecutive iterations these values do not
change significantly, the height of the groundwater table and the associated
transmissivity have been calculated correctly. If there is a significant difference, we'll
update the transmissivity and proceed with step c).

c) We will enter new transmissivity values, which remain linear dependent on the just
computed head values for all nodes (11 = h1 * 12), and go back to step b).

In practice:
From the main menu, select Calculate - Go Calculate (Figure 25).

Filez  Project “iew Commands | Calculate Options  Tools

Options. ..
Edit batch-file. ..

Figure 25: Calculate command

You'll see a pop-up window as in Figure 26:
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Al Calculation of Heads

19.00

Stop |

mﬂunl

Figure 26: Calculation progress window

In this window the number of iterations and the improvement in the last iteration (both in
terms of head difference and mean water balance error) are shown. As soon as the final
solution is calculated, the window disappears and the map area will be redrawn.

We will now make a map of the computed groundwater level.

1. Go to Drawing mode (click on the ﬁl—button).

2. Select a desired contour line color, e.g., light blue, by clicking on a light-blue square in
EIIIIIFFF
the color palette == | " " W®I A star emerges in this square, indicating that light-blue

will be used for all ensuing drawings.

Select as drawing subject the head: click in the cell next to h1.

Either click on the -button, press F7, or from the main menu, select Command >
Draw contours. You'll now see the following pop-up window (Figure 27):

head:¥:fm]

b irirmLirm IEE.EIEIEI '8

b i |42.I34‘I
Cancel
[nteral Im

[~ “within specified range

Help

[T Innon-marked area only

Figure 27: Contour pop-up window (2)

Instead of continuing on rapidly, we'll have a closer look at this window. First of all,
MicroFEM shows the lowest and highest values of the parameter to be contoured in the
displayed model area (35.0 and 42.041 m, respectively). From this we learn that the
lowest head is 35.0 m, which is quite reasonable as we expect that all heads between the
rivers are higher than the (fixed) heads of 35.0 m along the river boundaries. We also
learn that the highest head is 42.041 m above the base of the aquifer, implying that the
currently computed maximum height of the groundwater mound equals 42.041 — 35.0 =
7.041 m.

MicroFEM also suggests a reasonable contour interval (in this case, 0.5 m).
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You are free to substitute other values here, e.g. a contour interval of 0.1 m, by simply
specifying that value in the "Interval" field. You can also limit contour drawing to only the
interval from 37.0 to 39.0 m by specifying other values in the relevant.

The lowest check box ("In non-marked area only") allows you to only present results in a
restricted area.

OK, just leave the contour suggestions as they are and click on the OK-button. MicroFEM
will then draw a contour map of h1 (Figure 28):

Filez  Project “iew Commands Calculate Options  Tools  Import Export Help

F'alaml Top |

0 [head (m] [o.oo0
1 |wert. res. [d] |O
trans. [rEAd] [ 420
head [m] Bk 1
dizcharge [rrPf'd]ID

% | 1:Es | 1e22 | %=434330 y=2439.70 labe 1

om oo ekl R rnmn Si=l=l | alal @4 ARl

Figure 28: Contour map of h1, head in aquifer 1

We now have computed the head in aquifer 1, but actually for confined conditions. That is
because the transmissivity is still the same (420 m?/d) everywhere, while in a real unconfined
aquifer it is linearly dependent on the height of the groundwater table:

T = <saturated_thickness> X k.

To do better, we can improve the results step-by-step:

1.

We'll specify that t1 (transmissivity of aquifer 1) is linearly dependent on the computed
groundwater head, h1. Go to Input mode, click on the value cell of t1 and enter the
following formula:

h1*12 (without the spaces) and click on the gl—button (All nodes).

Everywhere in the model a better value for t1 has now been entered, based on the
computed height of the water table. However, an improved transmissivity will lead to
different heads.

Recalculate the model. In the main menu, select Calculate - Go calculate.
MicroFEM will not only recalculate the model, but also redraw the contour map based on
the newly computed h1-values.

To check the highest computed head, go back to Drawing mode, select h1 and click on

the -button (Draw contours), and just note the highest computed head (in my case |
found 41.419 m) and click in the contour pop-up window on the Cancel-button.
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You will probably find that you need one more iteration to obtain a maximum head of 41.448
m, or in other words, a mound height of 6.448 m above the river water levels.

Automatic calculation of unconfined conditions

In order to have MicroFEM compute an unconfined model automatically, we need to

incorporate a few more units:

¢ A thickness unit, where we will specify an initial thickness of the aquifer.

o A storage unit, where we will enter a storativity of O for all aquifers, implying steady-state
calculations.

¢ A batch-file where we will enter some simple commands for MicroFEM.

But first, we will exercise a bit of proper administration: click on Project > Information. The
Information window appears. Leave the model name at tutorial1 but make some notes in the
Remarks section to indicate that this model referred to manual calculation of unconfined
conditions (for instance, something like in Figure 29):

Project Information |
Mumber of nodez . 2415 Last update 13-04-03
Murber of elements : 4652 Prezent date 18-04-03
kodel name tutariall
Froject MicroFER turonal
Location zomemhere
D ate zome hime
Remarkz M arual zalculation of unconfined zaturated thickness

kMound height turned out to be 471448 m
|

Figure 29: Example updated Information window

Once you have made such changes and clicked on the OK-button, save the entire model
(File > Save all).

Next reset the model to the initial values. Assign a head of 35 m and a transmissivity of 420
m?/d to all nodes. Then, before proceeding further, again update the Remarks in the
Information window to indicate that we will now use automatic computation of unconfined
conditions; also change the Model Name field to tutorial2. We will then save the model with
other names for all units, to separate this new model step from the first one:

Click in the main menu on Project > Project manager. In the pop-up window first select the

fpr-file (the "project file") by clicking on it once. Then click on the .H_i-button and in the next
file-window, specify tutorial2 as file name (leave the file type, "Project file (*.fpr)", untouched).
Next in the Project manager window click on the Base model and save this with the same file
name (tutorial2) as the project file.

In principle, the precipitation unit does not have to be saved with another name, as long as
neither the finite element network nor the rate of recharge from precipitation are changed.

Now that the preliminary actions for the next calculation step are finished, we will add the
relevant stuff for automatic calculation of unconfined conditions:
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1.

In the main menu, select Project - Project manager. In the pop-up window (Figure 21),

click on the @'.l-button and in the next window (Figure 20) select "Thickness" and then
select "New" and click the “OK”-button.

Again click on the El—button in the Project manager window and in the next window
(Figure 20) select "Storativity" and "New"", and click the “OK”-button.

Now close the Project Manager window. In the MicroFEM data window, two new tabs
have been added. Click on the "Thick"-tab to display the thickness list:

Faram Thiﬂkl Stor I Top I
0 [top level [rn] {0.000
1 |aguitard [rn] j 0000

aquifer [rn] 111

Figure 30: New Thickness tab

In this example, the aquitard can be ignored (it is inactive and forms no part of the
model). We will have to enter an initial thickness for the aquifer. Just enter 35 m for all
nodes (Figure 30).

Next we will enter the initial top level, which is the height of the upper boundary of the
saturated part of the model relative to a standard reference level. Enter 35 m for all
nodes.

Click on the "Stor"-tab. MicroFEM deals only with storage in the aquifers. As there is only
one aquifer in the model, there is also just one position in the storativity unit. Although all
new storativities are set to zero initially, we will enter this value anyway (just to be sure).
Click on the storativity-field, enter a "0" (zero) and either press the F5-key or click on the

g—button. Finally, click on the "Param"-tab to return to the head information.

We are now through with specifying extra parameters. What is left is to specify how the
calculation of the model heads should be executed.

7. From the Main menu, select Calculate > Options. You'll see the following window (Figure

31):
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4l calculation options

Optians | Batchfie editor |

{~ Transient

[~ Bhreatic top aguiter

[~ Undo enabled

Hhdm lash ealzulation |

[~ Saveogfilz

Calculate | E:-l El

Figure 31: Calculate window (1)

The "Phreatic top aquifer" check box section is still grayed-out. To make this option
accessible, we must set up a calculation batch-file, a so-called .feb-file or MicroFEM

batch-file.

8. Click on the "Batch-file editor"-tab. In the Calculate window a simple text editor appears

(Figure 32):

ﬂ Calculation options

Options  Batchfile editor |

=10l x|

LOAD
YEARS

OFEM-H MIMUTES
OFEM-Q STEPS
DR FACTOR
R SETMIMNUTES
FATH SETDAY'S
Bt SETYEARS
SAVE
HELP
CLOSE
CLEAR
DS
EHD

Calculate | %l El ak Cancel Help

Figure 32: Batch-file editor (1)

The left part (blue background) is actually a simple ASCII text editor, which allows all
regular edit actions (except formatting). In the right part two columns with keywords are

shown.
We need to enter the following instructions:

TIME DAYS=1 STEPS=5
RUN
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These instructions mean: We specify a simulation time of one day, divided into five equal
time steps (each time step will be equivalent to one of our previous manual iterations). The
next command (RUN) simply tells MicroFEM to go ahead with calculating the solution.

We can either simply type this in, or we can first double-click on the keyword TIME, then
double-click on the keyword DAYS (the keyword DAY S= appears) and type manually 1
(for the number of days), and finally on the keyword STEPS (the keyword STEPS=
appears) and type manually 5 (for the number of steps).

Note: Because this example is a steady-state model (since the storativity is set to zero),
the actual time period does not matter — we could even have entered one second.
However, as we noticed when we manually did the transmissivity adjustments, we need
at least three steps. (Here we take five, just to be sure. After all, MicroFEM takes care of
the iterations instead of us, so a few extra won't hurt.) MicroFEM will adjust the
transmissivities of the phreatic aquifer only at the end of each time step. In more complex
problems, especially when dealing with multiple aquifers, many more steps may be
needed.

Using the second way to enter the batch-file statements (double-clicking on the
keywords), the batch-file will look like Figure 33:

Figure 33: Complete batch-file (1)

The formatting of this batch-file is quite irrelevant; the order of the statements does
matter. Be sure to close the Batch-file editor with the “OK”-button to save the batch—file in
memory.

See the on-line Help file for more info on MicroFEM batch-files.

9. In the Main Menu click on "Calculate", then click on the Options-tab. The "Phreatic top
aquifer" option is now accessible. Place a check mark at this option (Figure 34), then
click on the OK-button. Just leave the other options and fields untouched.

_ioix

Options | Batch-fie editar |

" Steady state

Fimirnum iterations |20

9 Uparneiar b awimum iterations {5000

o Relaxation factor |0

Water balance ermar [0

[~ Unda enabled

Whde last calculation

[~ Save log file

Eglu:ulatel lE:-l El ak I Cancel | Help

Figure 34: Calculate window (2)
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10. Before proceeding further, save the project (File > Save all). You will be asked to supply
names for the newly created thickness and storage units and for the batch-file.

11. Go to Drawing mode (ﬁl) and then, from the main menu, select Calculate > Options
and then press the Calculate-button. A pop-up window will appear (“Calculation of
heads”) with info on the current iterations. When the calculations are ready, press the
Stop-button; then press the OK-button to remove the calculation window. The contour
map of the water table in aquifer 1 will be redrawn.

12. Check the computed maximum head using the -button. In my case, the maximum
groundwater head was 41.448 m, exactly the same result as obtained with the manually
adjusted transmissivities.

Drawing a head profile and a cross section

To have a better view of both the groundwater mound and the saturated thickness of the first
aquifer, we can draw head profiles and cross sections.

1. Go to Drawing mode (if this was not already the case) and either click on the ‘iid-button
(to the right of the color palette), press F10 or select Commands - Select profile. A line
will appear on the map window. Position the mouse cursor somewhere on the northern
model boundary and left click. Next position the mouse cursor somewhere on the
southern model boundary and right click. This way the cross-section and head-profile
trace has been selected (Figure 35):

Filez Project “iew Command: Calculate Option: Tool:  Import Export Help

Param | Thick | Ster | Top |

.............................................. — 1 6.00¢
1 |wert res. [d] |O

trans. [reéAd] |452.6

head [m] {41.048
dizcharge [wé/d] |0

276 | 10Es | 4@ | x=-443.23 y=1289.28 label 1
@ml 3 [ClOols ERrr e an-

£l 2|

Figure 35: Selection of cross-section / head-profile trace

2. To avoid cluttering up the selection of the cross-section / head-profile trace by spurious

mouse clicks in the map window, click again on the Ziib-button (or press F10, or deselect
the Select profile-option in the Command drop-down menu) to remove this trace.

3. Either click on the g—button, press F11 or from the main menu select Command >
Draw profile. You will see a head profile with a black background and white axes.

4. Either click on the El-button, press F12 or from the main menu select Command >
Draw section. A cross section appears, again with a black background and white axes.

5. In order to save ink, in Figure 38 a white background and black axes have been selected.
To do this, in the main menu select Options - Profile... and Options - Section... In the
pop-up window, select white for the background and black for the axes colors. In the
example picture of Figure 38, the color of h1 in the head profile was set to blue by
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clicking on Head 1 in the right part and then clicking on the blue square in the color
palette in the left part (Figure 36):

Profile Options |

Ceale  Colors |

—color of head

[ | HeadO
Head 1

1 = || [ ]

—Background colar—————— |'.-’-'-.:-ces ol

] Cancel | Help

Figure 36: Head-profile options window, colors tab

6. In the cross-section window, similar action was taken with regard to aquifer and aquitard
colors. Left clicking in the color palette selects aquifers color, right clicking the aquitards
color. In addition, in the Layers tab additional options can be found (patterns etc.) to
further brush-up the cross section (Figure 37):

Section Options |

Scale I Colors  Layers | F|DW|inEI

—Aquifer brush patterr Layers——
f* Solid i Left hatched

LppEr: |1 3’
" Clear i~ Right hatched
" Horizortal ine € Cross lowver. I-I Ev
" Yerlical line i~ Diagonal cross

—Aquitard brush pattern
= Solid Left hatched

~
" Clear i~ Right hatched
{~ Haonizontal ine & Cross

o

" Yerlical line Diagonal crozs

Cancel Help

Figure 37: Section options, Layers tab

7. In addition, under the Scale tabs several other options can be selected, like automatic
versus manual scale, scale intervals, etc. If you are content with the colors, select
Options > Save settings from the main menu to save them.

The head profile and cross section together with the MicroFEM window look like Figure 38:
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Figure 38: MicroFEM window with head profile and cross section

Drawing 3D views of the head surface and aquifers

Since MicroFEM version 3.60.34 a 3D-viewer has been supplied which allows 3D
perspective views of various contour surfaces, aquifer build-up and flowlines. We will now
use this to show the head surface.

From the main MicroFEM menu select Tools = 3D Viewer. This will open a window like
Figure 39:

# 3D viewer =10] x|

Show Tools Export Help

B+ = &l

Wiewy point x,y,2: -1818,-19727,115 m ‘Vert. exaggeration: 121 | A

Figure 39: Initial 3D Viewer window
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What is shown in Figure 39 is:

o Ared “bounding box”. This is the smallest box that contains the model. The edges of the
bounding box are aligned with the x-y-z axis system

e Three coordinate axes in blue (Y or NS), red (X or EW) and green (Z)

e A curved yellow surface, i.e., the head surface of aquifer 1

o Aflat green surface, representing the head surface of aquifer 0.

You can use the mouse cursor for a number of simple operations:

» Rotating the model around the Z-axis (hold the left mouse button and move the mouse
cursor in horizontal direction)

» Tilting the picture around a horizontal line parallel to the screen (hold the left mouse
button and move the mouse cursor gently in vertical direction)

» A combination of rotating around the Z-axis and tilting

» Zooming in (pressing down the right mouse button and —gently!- moving the mouse
cursor in a vertical fashion)

» Changing the vertical exaggeration (while keeping the Ctrl-key depressed, press the left
mouse button and move the mouse cursor —again, gently- in a vertical fashion)

» Changing the degree of perspective (while keeping the Shift-key depressed, press the
right mouse button and move the mouse cursor —again, gently- in a vertical fashion).

Currently this picture is as much as we can get. The aquifer bottom is at the same level as
hO, while the water table (h1) is given by the yellow surface.
But at later stages the 3D picture will become more interesting. Hold on.

Calculating a water balance of the model

A water balance is the most powerful check on the validity of any groundwater model.
MicroFEM makes it quite easy to calculate water balances. First we will compute the water
balance of the entire model; at later stages we will compute water balances for parts of the
model.

Go to Walking mode and then, either click on the "_I"l-button (Water balance all nodes), or
press the F5-key, or select the Command > Waterbalance all nodes-command from the
main menu. That's all there is to compute an overall water balance for a steady-state model.
After a short spell, the following water balance window pops up (Figure 40):

JRI=TEY
Bl 2 ey
Il I [ uitFlons I I - Ot I
Precipitatian 394261 394261
Sum topsystems 394261 94261
Leakage
1 Lateral flow
Boundary flow 33424.8 -33424.8
el Fliow
Total [error) F94261 394248 1.4

Figure 40: Water balance window (1)

In Figure 40, the following elements can be distinguished:

e Three columns with inflow, outflow and net inflow (inflow — outflow), all summed over all
nodes for which the water balance was calculated (in this case, the entire model).

e The upper rows comprise water balances for each individual top system, and the sum of
all the top systems.
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o Leakage comprises flow through the overlying aquitard into the aquifer. We have
disabled the covering layer by making it impermeable (as explained on page 19), so this
part of the water balance is ignored.

e Lateral flow means all the groundwater that flows laterally in or out the water balance
area, except for boundary flow.

¢ Boundary flow consists of all groundwater that flows laterally across the model
boundaries (because of fixed-head boundary conditions).

o Well flow speaks for itself.

e The total inflow, the total outflow and their difference, the water balance error, is
displayed on the last line. To reduce this error, more iterations per time step will help.

Looking at the above figures, you might wonder: "Why is there no lateral outflow across the
northern and southern model boundaries?".

The answer is that this outflow is included in the term "Boundary flow", According to the
above description, lateral flow will be zero for any water balance of an entire model. Lateral
flow is only computed when a water balance is set up for a part of a model.

Preparations for computing the effects of the well abstraction

In order to be able to compute and visualize the effects of the well (which will be computed in
the next section) we have to prepare a few things. We need to store the computed heads for
the situation without a well somewhere in a safe place, in order to be able to compare this
with the computed heads in the situation that includes a well abstraction.

(Because we are dealing with an unconfined situation, we cannot simply compute the effects
in superposition; we do need to compare two individual situations.)

MicroFEM offers two ways to handle this:
1. Parameter files, and
2. Worksheet.

Parameter files

This is the traditional way to save intermediate results. Apart from saving computed results
for later comparison, parameter files are also used for cooking up lots of data files needed in
complicated (often transient) model calculations with complex top systems, time-dependent
boundary conditions etc. For your info: all topsystems, storativity files and lots of other files
belonging to a MicroFEM project may actually be kept in parameter files.

But for now we will keep it easy and just save the computed water table levels to a parameter
file:

1. Go to Input mode and select h1 as the current parameter (just click once on a h1 value).

2. Either click in the toolbar below on the E—button, or press the F12-key, or select
Command - Save parameter file from the main menu. In the ensuing file pop-up window
(Figure 41), leave the file type as Parameter file and supply a suitable name. MicroFEM
supplies a default file name comprising of the base model's name and an extension
referring to the parameter type (see on-line help for an overview of file extensions).
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Save a Parameter File |
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Figure 41: Parameter file I/O window

3. Simply click on the "Save"-button.

That's it for now. We will use this parameter file after we have computed the water table
levels with the abstraction well included.

Worksheet

A MicroFEM worksheet combines features of a scratch notepad and a spreadsheet. It is
simply a stack of model "layers", however these layers have nothing to do with the actual
geohydrological model build-up, but are just placeholders for intermediate or scratch values
for all nodes in the model.

We'll first add a worksheet to our model:

1. Select Project = Project Manager from the main menu, click on the El—button, select
"Xtra worksheet", click the “New” radio button in the next window and press “OK”. In the
next pop-up window, a number of 12 registers is suggested (Figure 42).

x

Mumber of registers |12 -

Cancel |

Figure 42: Xtra worksheet Registers pop-up window

Click on the OK-button to accept this number of registers. By the way, it is easy to add
extra registers at later stages (see the On-line Help).

2. Close the Project manager window. In MicroFEM’s data window a new tab has appeared
("Xtra").

3. To the left there is a column of register names, which by default have no names but can

be referred to as x1 to x12. We will for now just use one register to store our h1 values,
and to remind us what values this register contains, we will change its name:
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4. First make sure you are in Input mode. Right click on the number (x1) or text part (...) of
the x1-row (a picture similar to Figure 43 will appear):and enter the name "h1 w/o well"
(without quotes) and click on the OK-button or press the Enter-key.

Param| Thick | Stor | Top  Xta |

Wl
L eI - M-

Enter a regizter name E I_

Feqister name aof 1
ﬁ S
QK I Cancel

Figure 43: Changing register name

5. Then click on the value cell in the x1 row, press the Enter-key, enter just “h1” (without

quotes) and press the Ql-button (All nodes). Now all h1-values are copied to the x1- or
"h1 w/o well"-register (Figure 44):

Param| Thick | Stor | Top  ®lra |

%1 | bl wio well :
w2 n
Figure 44: h1-values saved in register 1
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STEP 4: CALCULATING THE MODEL IN STEADY
STATE WITH A WELL ABSTRACTION

We will now add the well abstraction to the model and recompute the head distribution.

1.

Close the cross-section and head-profile windows, click on the well discharge field in the
parameter list to make it active.

Select Walking mode. Click on the '_"'I-button (Jump to node), in the pop-up window
select "Next label", select the label "well", press the Jump-button and then close the
"Jump to node" pop-up window.

Select Input mode. Press the Enter-key to open the cell and enter a discharge rate of
8000 m*/d and press the Enter-key again to assign this value to the current node. The
discharge has now been entered. Next, check in the Calculation options window that
there is a check mark next to “Phreatic top aquifer”. Calculate the model (press the
Calculate-button). After the calculations are finished, press the “Stop”-button and the
“OK”-button, and go to Drawing mode. The contour map will be redrawn, showing the
effects of the well abstraction. That's it! The new situation has now been computed.

First we will improve the map picture a little bit.

In order to do away with the cluttering up of the picture by the nodal points, we will clear
these. Select Options > Map... from the main menu. In the pop-up window (Figure 45), a
list of currently drawn items is shown together with their color and (when applicable) with
contour interval etc. mentioned below when such an item is selected. Using the buttons in
the right part the order of drawing of these items can be changed, items can be made
temporarily "inactive" (not drawn) or they can be completely dropped from the drawing
list. For now, select the item "Node points", remove the check mark in front of it and press
the “OK”-button.

Al M ap options
Drawing mode |.-’-'-.Iter-gri|:| mu:u:lel Colars I
Drawing components
B head 1 [m] ﬂi kowve up
Made paints
ﬁ it =40 [
x Delete
k. Cancel | Help |

Figure 45: Map options window

_ o I
To draw the model boundary in black, click in the color palette = BI= " 7= =& on the

black square and then click on the gl—button or press the F5-key (Draw boundary).

5. We also want to draw a cross section and head profile between the well and the landfill.

To indicate them on the contour map, we will use a little trick. In the Xtra worksheet, we
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will make some "markers". Go to Input mode, select the Xtra-tab. Jump to the well and
enter a value of e.g., 10 in x2. Jump to the landfill node and enter the same value in that
node in the x2-register. Then contour x2 in a contrasting color, e.g. red.

The resulting map will look like Figure 46:

Figure 46: Computed heads contour map with well abstraction

The red spots in Figure 45 are of a different size, related to the spacing of the nodes. To
obtain red circles of the same size, select in drawing mode F8 (draw vectors or circles), set
the size to 10, check the box “draw discs” and press the OK-button.

6. Now again click on the :il-button (Select profile) to position the cross-section trace from
the northern to the southern model boundary, along the line connecting the landfill and
the well (left mouse button = left extreme, right mouse button = right extreme). Now click
again on the :i-button to deselect it; open a head-profile window and a cross-section
window to obtain the following pictures Figure 47:
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Figure 47: Head profile and cross section across well

To view the head surface in 3D, select Tools - 3D Viewer from the main menu. You will now
see a curved surface with a clear depression cone around the well (Figure 48).
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M 3D Viewer 10| x|

Show Tools Export Help

&~ 2| &

View point x,y,2: -5243,-14251,64 m YWert, exaggeration: 123 A

Figure 48: 3D perspective view of head surface and depression cone

To show the well itself (as in Figure 48), select Tools - Options from the 3D viewer window

menu or press the -button. The 3D-Viewer Options menu wil pop up. Click on the Wells
tab to obtain a window like Figure 49:

# 3D Viewer Options =10 x|

Wiew I Geu:-metr_l,ll Aquifers el |ﬂeads| Elowlinesl Extra I

ol o W

Select all | Clear all

Hep | Aol | x|

Figure 49: 3D Viewer Options menu (Wells tab)

Click on the blue cell next to “1971” (which is the node number of the well) to place a cross
there and —if desired- click on the color palette to the right to select a drawing color for the

well.

December 2010 46 of 57



MicroFEM tutorial version 4.10

STEP 5: COMPUTING THE EFFECTS OF THE WELL
ABSTRACTION

The effects of the well abstraction in terms of water table drawdowns can be calculated by
subtracting the computed heads in the situation with a well, from the computed heads in the
situation without a well.

We will use two methods for this calculation:
a) by saving and loading parameter files
b) by using the Xtra worksheet.

Using parameter files

In order to use the parameter file we have saved at the end of step 3, we first have to find a
parameter in the actual model that we do not use currently.

Because we have inactivated the head-dependent top system, MicroFEM ignores the values
in h0. So, this h0 is a possible place to store the h1 file data, which we previously saved.

Make sure MicroFEM is in Input mode. Then select h0 by clicking once on the hO cell.

2. Either: click on the El-button, press the F11-key or select Command, Read parameter
file from the main menu.

3. Inthe ensuing file pop-up window, select the file tutorial2.h1 (or whatever name you gave
it) we made in step 2 (page 41) and click on the "Read"-button.

The previously computed water table level without the well is now available in h0. To
compute the drawdowns caused by the well abstraction alone, we'll have to find the
difference between the water tables for the two situations.

4. Click once on the h0 value cell, and press Enter.

5. Enter the following formula: p-h1 and press the F5-key. This formula means: subtract the
computed value of h1 (water table with the well abstraction) from the present value in hO,
which is the water table level in the situation without the well abstraction.

6. The drawdowns are now present in hO and can be easily contoured:

7. Go to Drawing mode and check that h0 is still selected. Click on the green square in the

palette (contours will now be green). Then click on the -button, select a contour
interval of 1 m in the pop-up window and click on the OK-button (or press the Enter-key).
You will see a contour map like in Figure 50:

The above method is an example of the use of parameter files, while it also shows that you
can sometimes play tricks on MicroFEM by entering values at places that are intended for
something else. However, the next method should be preferred. It uses the Xtra worksheet,
which has been especially designed to manipulate nodal values, without bothering the proper
model parameters.
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Figure 50: Computed well drawdowns (green)

Using the Xtra worksheet

In this case we can use the previously computed results (water table level without well
abstraction) which have been stored in the x1-register (“h1 w/o well”’). We proceed like this:

1. Go to mode 2 (Input mode) and click on the Xtra tab. Right click on the third row (x3;
remember, in x2 we kept the marks of the landfill and the well) and rename the x3-
register to "drawdowns" (without the quotes).

2. Click in the x3 cell and enter the formula: x1-h1 and press the F5 key. Presto! The
computed drawdowns are now in register x3.

Please note that "x3" is a parameter code recognized by MicroFEM. You can only use these
parameter codes in formulas, not the names you have given them. Look for “parameter
codes” in the on-line Help system for a full list of them.

3. To contour these drawdowns: Go to Drawing mode, click on the green square in the color

palette and then on the -button. Again select a contour interval of 1 m and press the
Enter-key. The result should be exactly the same as in Figure 50.

To see the head differences in the 3D viewer, press Tools = 3D Viewer, click the button
in the 3D viewer window, select the Aquifers, Wells and Heads tab and deselect everything
(“clear all”). Next click on the Xtra tab, place a check mark in front of x3, select a suitable
color in the palette (e.g., blue) and click on “OK”. The result will look like Figure 51:

M 3D Viewer =1of x|

Show  Tools Export Help

Gl =| &l

|V|ew point x,y,2: -6545,-15694,71 m |Vert. exaggeration: 123 | &

Figure 51: 3D view of drawdowns in Xtra register
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STEP 6: DELINEATING THE WELL RECHARGE AREA

For many purposes it is important to know from which area the well captures the recharge;
e.g., for the delineation of a well protection zone.

In our simple example the contour plot of Figure 46 shows the position of the recharge area
quite clearly, but in many cases this is not that obvious.

Using 3-dimensional flowlines

The next procedure shows how to trace a number of flowlines emanating from the well in
upstream direction and see where they reach the water table.

1.

Go to Walking mode and select h1 (head in aquifer 1). Click on the j—button and either
select "Next well" or the label "well", click on the Jump-button and close the pop-up
window. Check that the current node is indeed the well node (the discharge should read
IISOOOII)

Go to Drawing mode and either click on the %l—button, press the F9-key, or select
Command - Draw flowlines from the main menu. A new pop-up window appears (Figure

52):
x4
Ok
Direction ; n lines A0
" Fanward Time step ] 1] Cancel
{* Backward Levels 099
Porosity (<11 [0.3 Help
Save file : Max time (] 0
" MNofile Lichive |abel 1 vI
& i [~ Logarithmic timesteps
(" Flowline file [T Stopin marked area

Filename : tutoriald #01

Figure 52: Flowline window

In this window you can specify exactly how you want your flowlines drawn. A bit of

explanation:

Direction: in our case, Forward and Backward actually mean Downstream and Upstream.
As we want to trace upstream we select Backward.

Save file: Although flowlines are easily redrawn, we can save them for later use, e.g.
plotting in a cross section. So we specify "Flowline file", and then MicroFEM
suggests a filename for the flowline file. We think that the suggested name
"tutorial #01" should do, but if you don't like this name, just press the Browse button
and specify a new name. "Short file" is a special file format for a.o., response curves
and chemical modeling — a too advanced issue to deal with here.

n lines: Here one can specify the number of flowlines emanating from the well. This field
is only accessible if in the current node and in the current aquifer a discharge is
modeled; in all other cases it is grayed out and a "1" is shown.

Time step: Time steps (travel time markers) can be drawn on the flowlines on regular
time intervals. For our purpose we do not need this, so we enter zero to indicate we
do not want time steps drawn.
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Levels: This is an important one. This field is only shown if a thickness unit is part of the
model (as we have done to be able to deal with an unconfined aquifer). Here we can
specify the relative depth level (or the depth levels) where the flowlines should start.
A positive number between 0 and 1 implies just a particular depth level, where 0
means the top of the aquifer and 1 the bottom. An integer number larger than 1
implies as many depth levels (and flow lines), evenly divided over the full depth
range of the aquifer. We enter 0.99 to indicate that the starting level must be just
above the bottom of the aquifer, to avoid numerical problems in stagnation zones
near the groundwater divide.

Porosity: The effective porosity of the medium is only required to compute time step
markers. In MicroFEM, porosity is specified as a single value, valid for the entire
model. For our purpose this porosity is irrelevant, so we just leave it at the default
value of 0.3.

Max. time (y): Normally flowlines are traced all the way until they either leave the
displayed part of the model, or until the model boundary is reached somewhere,
irrespective of the computed flow time. In this field a maximum flow time can be
specified, handy for delineating e.g. 25-year zones around a well. For our purpose,
we want to trace all the way, so we leave the default zero value, which indicates
unlimited time.

Active label: When flowlines are drawn, starting locations are determined by all nodes on
the screen with the same label as the current node. If the node does not have a
label, the flowlines are only drawn for the current node. In case more than 1 label
file is loaded, the user can specify here, which label file has to be used to determine
the starting locations._

Logarithmic time steps: Speaks for itself, only useful in some cases of well abstractions
but not in ours. Just leave blank.

Stop in marked area: Speaks for itself, too. Sometimes handy to avoid cluttering up a
picture.

3. After having entered the information as indicated in the explanation above, we simply
click on the OK-button and watch the flowlines being drawn. After a while, we get the
following picture (Figure 53):

Figure 53: Computed 3D-flowlines from the well

In this picture all flowlines are drawn in yellow. Perhaps we would have liked another color,
but for 3D-flowlines MicroFEM substitutes default colors depending on the aquifer where the
flowline currently is: Yellow for the first aquifer, Blue for the second, Green for the third, and
so on. (Note: these default colors can be changed (“Options -> Map Color”) and saved
(“Options -> Save settings”).
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In Figure 53 we can see that the recharge area of the well has a butterfly-like shape, and
(most importantly) that the landfill lies outside the recharge area of the well. Polluted
groundwater leaching from the landfill does not threaten the well abstraction.

Plotting 3D-flowlines in cross sections

It is also very instructive to plot the flowlines in a cross section. We will do this as follows:

1. Simply go to Drawing mode, click on the iiil-button and select a suitable cross-section

trace. Then simply click on the !—button and the cross section will appear more or less

like Figure 54 (in case of the same cross section over the landfill and the well of Figure
47):.

_43/MicroFEM 3.50 - tutorial3 M 5ection [_ (3] x|
Filez  Project “iew Commands Calculate  Option

1971 | 1:1Es | 2384 |
o/m| | [OlC]s#lold E ) Z

Figure 54: Cross section with flowlines (1)

2. Admittedly, the flowlines do not look very impressive in the cross section, where some
flowlines are only partly displayed. This is actually caused by the width of the flowline
area, which is the area between the two (light-blue) lines at both sides of the (dark-blue)
cross-section trace (see Figure 54). Only those parts of the flowlines are projected onto
the section that lie within the flowline area.

To change the width of this area, go to Options = Section... in the main menu, select the
Flowline tab and enter a much larger width for the flowline area, e.g., 3000 m (Figure 55:
Section Options window, flowlines tab):

Section Options

Scale I I::::I::ursl Layers Flowline |

Wwhidth of flowline area |3|:||:":|

Figure 55: Section Options window, flowlines tab

3. Once the OK-button on this Section Options window is clicked, the cross section looks
like Figure 56:
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Figure 56: Cross section with 3D-flowlines (2)

One may wonder why in Figure 56 most flowlines end higher than the groundwater table.
Well, that is due to the fact that all (parts of) flowlines within the flowline area are simply
projected onto the vertical plane through the cross-section trace. The upper ends of the
flowlines are determined by the water table level at the boundary of the capture zone.

Drawing 3D flowlines in perspective view

It is even more instructive to see how 3D flowlines look like in a perpective 3D view. Bring up

the 3D Viewer window, click on (Options) and select the Flowlines tab. Click on “Add
flowline”, in the ensueing file window select the flowline. Now in the 3D viewer window select
a nice color for the flow line and click on “OK”. After some turning and tilting results similar to
Figure 57 may be obtained:
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Figure 57: 3D views of flowlines to the well
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STEP 7: TRANSIENT CALCULATIONS

As an example of transient model simulations, we will compute some time-dependent draw-
down curves caused by the well abstraction. We will start from the situation without well
abstraction (tutorial2) we've created using the automatic option (with batch-file, thickness and
storativity units).

1.

2.

4.

Click on Files & Clear in the main menu. Then load the model tutorial2 (Files = Open).

Check in Calculate - Options that the checkbox next to “Phreatic top aquifer” is
checked.

Go to Input mode. Click on the Stor tab in MicroFEM’s data window, then click on the cell
next to coefficient. Enter a storage coefficient of 0.2 and assign this to all nodes (F5-key

or gl-button).

Go to Walking mode, jump to the well, assign a discharge rate of 8000 m*/d to g1.

We want to compute time-drawdown curves for fictitious piezometers at a distance of about
200, 500, 1000 and 2000 m due north of the well. An easy way to find the locations of
suitable nodes is as follows:

a) Go to Input mode, click on the Xtra-tab, rename row x3 to "r" (without quotes) and
assign the variable r to all nodes (r means distance to current node. The well is
assumed to be still the current node).

b) Go to Drawing mode and contour register x3 with (initially) an interval of 200.

c) Again contour register x3, with another color, using an interval of 500.

d) Zoom in on the well (with the well node still current, use the .G_}\.l-button) until the
innermost contour fills the screen.

e) Click on the node closest to the contour, due north of the well, to make it the current
node.

f) Go to Input mode. Click on the label field and assign the node the name "p200"
(without quotes).

g) Now zoom out (use the El—button) until the contour of 500 is fully visible. Click on
the node that is closest to the contour and lies due north of the well to make it current
and assign it a label name of "p500".

h) Continue to name nodes at a distance of 1000 and 2000 m "p1000" and "p2000",
respectively.

i) Finally, clear the contours of x3 from the drawing list (Options > Map...).

j) To have some idea where the piezometer nodes are located, make a contour map of
label 1 (yes, that is perfectly possible. MicroFEM draws lines between adjacent nodes
with different labels).

We now have to change the batch-file to indicate for which nodes time-drawdown info
should be saved and we also have to indicate proper stress period and time step
information. In Calculate > Edit batch-file. Make sure that the batch-file will look like the
following:

OPEN-H p=fth

TIME DAYS=1 STEPS=3
RUN

TIME DAYS=364 STEPS=10
RUN

TIME YEARS=9 STEPS=18
RUN

END
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The OPEN-H statement is to be interpreted as follows: OPEN a file <modelname>.fth
and write to this file the time-head information for all nodes that have a "p" somewhere in
their label name. As our piezometer label names all start with “p”, this will work well.

The first stress period lasts a day and is split into three equal time steps.

The second stress period lasts a year minus one day and is divided into ten equal time
steps.

The third and last stress period lasts ten minus one years and is split up into18 steps.

Click on the “OK”-button to store the batch-file in memory.

6. Save the entire project under a different name. In Project = Project manager, click on the

uppermost unit (the Project file, .fpr) to select it and then click on the Ej-button, change
the name into tutorial3.fpr and save it. Next select the base model and also save it with
the name tutorial3. Continue and rename all units this way.

An easier way is to click on the “Save all files as...” button, fill in “tutorial3” as base name
and click on OK.

7. Have a last check on the model and when you are satisfied, calculate the model results:
Calculate > Go calculate.

8. If the contour map is redrawn, it refers to the contour map of the head distribution after 10
years of well pumping. But the final situation is not the most interesting thing: what we
want to see is the transient result, as given by the time-head curves.

9. Click on the main menu on Tools = Time curves.... The time curve analysis window

appears. Click in this window on the El—button and in the file menu, select tutorial3.fth.
The time curves window will show the Selection tab which looks like this (Figure 58):

A Time-curve analysis - tutorial3.fth
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Figure 58: Time curves window, Selection tab

The options on this window tab are largely self-explanatory. Just leave all times and
nodes selected and click on the Options tab to see the picture of Figure 59
(if needed, drag the Options window wider to show it in full):
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Figure 59: Time curves window, Options tab

10. As usual, we want a white background and black axes, so we select these from the color
drop-down lists left below. Next, we click on the color palette to the left on a blue color to
have more contrast on the white background.

We now have to decide what we want to draw. For the time being, the default options as
indicated are OK. In addition we select a horizontal and vertical grid and "Nodes as
labels" option (that shows labels rather than node numbers on the graph).

11. Finally we click the Time-Head curve tab to see the graph of Figure 60:
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Figure 60: Time-Head curve
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Epilogue

This is the end of the MicroFEM tutorial. We hope you have enjoyed it and that you now
know enough of MicroFEM to get your first real project started. There are still many options
that are not yet discussed, like flow vectors, full-color graphs, flux functions, transient water
balances, and all Input and Output functions and formats. Just try out all options you can find
and make use of the on-line Help to get detailed information on MicroFEM's capabilities.
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